Mastering Your BERNINA® Embroidery Module/Machine

Owner’s Workbook
# Table of Contents

## Section A: Embroidery Beginnings

- **Introduction** .............................................................................. 4
- **General Information: Your Embroidery Machine/Module** .......... 5
- **4 Levels of BERNINA® v4.0 Embroidery Software** .................. 9
- **Getting Started** ........................................................................ 10
- **Needles** .................................................................................. 14
- **Thread** ..................................................................................... 16
- **Embroidery Thread** ................................................................... 17
- **Stabilizers & Interfacings** .......................................................... 18
- **Sewing & Craft Sprays** ............................................................... 19
- **Samples**
  - Stitching A Motif ..................................................................... 20
  - Monochrome Embroidery .................................................................. 22
  - Customizing Thread Color ................................................................. 24
  - Duplicating & Rescaling Motifs ......................................................... 26
  - Proportional Resizing of Motifs ......................................................... 28
  - Rotating Designs ............................................................................ 30
  - Proportional Resizing & Rotation ...................................................... 32
  - Stretching Designs ......................................................................... 34
  - Right-to-Left Mirror Image ............................................................... 36
  - Up-to-Down Mirror Image ................................................................. 38
  - Using Embroidery Cards ................................................................. 40
  - Using an Embroidery CD or USB stick ............................................... 42
- **Saving & Deleting Embroidery Motifs** ....................................... 44
- **Embroidery Beginnings Shopping List** ........................................ 46

## Section B: Beyond the Basics

- **General Information: Working with Alphabets & Text** ............... 48
- **Selecting, Adding, & Deleting Letters** ........................................ 49
- **Samples**
  - Alphabet Sampler ....................................................................... 52
  - Manipulating Alphabets ................................................................. 54
  - Stitch Density ................................................................................. 56
  - Combining Motifs ........................................................................... 58
  - Combining Lettering & Motifs ......................................................... 60
  - Rehooping ..................................................................................... 62
  - Free-Arm Embroidery .................................................................... 64
  - Baseline Sampler .......................................................................... 66
  - Changing Lettering Height ............................................................. 68
  - Changing Lettering Spacing ............................................................ 70
  - Mega Hoop .................................................................................. 72
  - *myartista* Portal ......................................................................... 74
- **Beyond the Basics Shopping List** ............................................... 76

©2006 BERNINA® of America, Inc. Permission to copy granted only to Authorized BERNINA® Dealers
Mastering Your
BERNINA®
Embroidery Module/Machine

Owner’s Workbook

Section A
Embroidery Beginnings
Introduction

Congratulations on your purchase of a BERNINA® embroidery machine and/or module!

This workbook is designed to be used in conjunction with the Owners Classes you will take at your BERNINA® dealership, and contains a series of exercises intended to familiarize you with the features of your new BERNINA®. In addition, you will learn about needles, threads, stabilizers, interfacing, embroidery hoops and accessories, all of which will increase your knowledge of sewing and assist you in achieving success in all of your sewing endeavors.

Once you have completed the exercises designated for your BERNINA® machine, attach the sewn samples to the indicated pages and insert the pages into plastic page protectors and store them in a 3-ring binder. They can then be used as a reference tool in the future as you use your machine and explore the creative possibilities it affords you.

BERNINA® of America, Inc. strives to provide its customers not just with quality sewing machines, but with informative publications and classes. Along with providing Owners Classes, your local BERNINA® dealer stocks BERNINA® books and magazines, such as ABC’s of Embroidery and Through the Needle. Plus, BERNINA® of America, Inc. has a website – www.berninausa.com – offering free projects and embroidery designs, inspirational stories, and interviews with creative stitchers.

Learn to use your BERNINA® machine to its full extent and enjoy being creative with fabric and thread!
General Information: Your Embroidery Machine/Module

Module/Machine Details
See Owners Manual for details.
- Card Slot
- USB Port
- Hoop Clamp
- Selection Menu
- Layout/Edit Screen(s)
- Embroidery/Stitch Screen

Selection Menus

Layout/Edit 1 & 2 Screens

Embroidery Screens
Embroidery Hoops

- **deco 330 Hoops**
  - Small Free-Arm Hoop - optional accessory
  - Medium Hoop - standard accessory
  - Large Hoop - standard accessory
  - Round Hoop - optional accessory

- **aurora & artista** Hoops
  - **Small**
    - standard for **artista** 730E
    - optional for **artista** 630E & 640E
    - optional for **aurora** 430E & 440QEE
  - Spacer for freearm embroidery
    - standard with **artista** 730E
    - optional for **artista** 630E & 640E
    - optional for **aurora** 430E & 440QEE
  - **Medium**
    - standard for **artista** 640E & 730E
    - optional for **artista** 630E
    - optional for **aurora** 430E & 440QEE
  - **Large Oval**
    - standard for **artista** 630E, 640E, and 730E
    - standard for **aurora** 430E & 440QEE
    - **Note**: optional Hoop’N’Buddyz Hat Hoop Insert
      - available for stitching caps (fits Large Oval only)
  - **Mega**
    - optional; available for **artista** 630E, 640E, and 730E
    - not available for **aurora** 430E & 440QEE

- **Hoop-It-All™** Hoops (optional)
  - **Note**: Not all hoops are available for all systems.
    - Quilters Square Double Wide
    - Super Double Wide
    - **deco 330 Double Wide**
    - Big/Cap

Additional Accessories

- Hoop Templates (included with hoops)
- Spool Caps
- Thread Net - helps control slippery embroidery threads
- Supplemental/Silky Thread Guide (**artista & aurora** only)
Notes

• Multi-Spool Thread Stand  (adapter bases available for all BERNINA® embroidery systems)
• Multi-Spool Thread Stand Extender
  - holds three additional spools
  - Thread Stand accommodates two Extenders
• Straight Stitch Plate (optional, artista & aurora only)
• Embroidery (gold latch) Bobbin Case
  (artista 640E & 730E only)
• Dust Cover (deco only)
• Zippered Travel Bag for Module
• Suitcase System (optional for all machines and modules)

Studio BERNINA® Embroidery Collections
• .exp formatted cards for deco 330/500/600/650 & artista systems (aurora systems: access cards via Magic Box Plus)
• non-encrypted, multi-format CDs including true .art files for use with the artista 730E through the CD drive, or for use with all other BERNINA® Embroidery Systems through BERNINA® Embroidery Software (Editor Lite through Designer Plus)
• .art formatted CDs for artista 730E & BERNINA® Embroidery Software
• multi-formatted (including .art) USB sticks for artista embroidery systems & BERNINA® Embroidery Software
• Embroidery Take-Out design CDs available through dealers
• www.embroideryonline.com – downloadable design files

Needles
• Types/Sizes/Parts - see information on pages 14-15
• Match needle size and type to thread size & fabric type
• For more information: Features Volume 3, Unit P, pages 1-11

Embroidery & Bobbin Thread
Good quality vs. poor quality: the better the thread, the better the results and the easier the process
Fiber content: different types (polyester, nylon, rayon, cotton, metallic, acrylic, etc.) produce different results
Thread weight: the thicker the thread, the denser the stitching – embroidery designs are generally digitized for use with 40 weight embroidery threads such as Isacord or Polysheen
**Software and Peripherals**

- **BERNINA® Embroidery Software**
  - Editor Lite (available for *aurora & artista* systems only)
  - Editor
  - Auto-Designer
  - Designer Plus

- **USB Cable** (standard with *aurora & artista* systems)
  to connect embroidery system to computer

- **BERNINA® CD Drive** (optional accessory for *artista* 730E only)

- **BERNINA® Modem** for dial-up service providers (optional accessory for *artista* 200E/730E only)

- **BERNINA® Ethernet LAN card** for broadband (highspeed) service providers (optional accessory for *artista* 200E/730E only)

- **Magic Box Plus & Mini Magic Box Plus**
  - Used to transfer designs to *artista* Magic card for *deco* 330
  - Used to convert non-.art design cards
  - Used by the *aurora* embroidery system to access Studio BERNINA® embroidery card files
  - Used to transfer .art files (in .exp format) to *artista* Magic Card for *artista* 730E
  - Used to read non-.art design collection files into the BERNINA® Embroidery Software

- **Swap Box**
  - Used to convert *deco* 500/600/650 cards to *deco* 330
  - Used to transfer designs from *deco* 500/600/650 cards to *artista* Swap Card for use in *deco* 330 and *artista* embroidery systems

- **USB PC Card Reader from OESD**
  - Used to transfer designs from PC to *artista* 730E & *deco* 330 Personal Design Card
4 Levels of BERNINA® v4.0 Embroidery Software

There are 4 levels of BERNINA® version 4.0 Embroidery Software: Editor Lite (available only with aura & artista 630E/640E/730E embroidery systems), Editor, Auto-Designer, & Designer Plus. For a complete comparison chart, visit www.berninausa.com.

Editor Lite v4.0
Basic customizing software for quickly & easily combining designs & text. Functions as the “editing screen” for the aurora embroidery system, and as an alternate “editing” screen for the artista 630E/640E/730E
• For the user that wishes to combine and re-color designs
• For the user that wishes to add text and manipulate lettering
• For users wishing to work with design CDs, USB sticks, and/or designs downloaded from www.embroideryonline.com
• Can use Magic Box Plus and artista Magic Card, and/or USB PC Card Reader and artista 200E/730E Personal Design Card, and/or BERNINA® USB Stick
• Integral part of the aurora embroidery system
• Also included with artista 630E/640E/730E embroidery systems

Editor v4.0
Powerful but easy-to-use software for making changes to existing designs.
• For the user that wishes to customize and edit designs and lettering
• For users wishing to work with designs from cards, disks, CDs, USB sticks, and/or designs downloaded from Internet
• Includes the Cross Stitch Program
• Includes the BERNINA® Quilter Program
• Can use the Reader/Writer Box and Personal Design Cards
• Can use the Magic Box Plus and artista Magic Card, and/or the USB PC Card Reader and the artista 200E/730E
  Personal Design Card, and/or BERNINA® USB stick

Auto-Designer v4.0
Create professional-looking embroidery designs in seconds.
• For the user that wishes to customize and edit designs and lettering
• For users wishing to work with designs from cards, disks, CDs, USB sticks, and/or designs downloaded from Internet
• For the user that wishes to create (digitize) designs automatically
• Includes the Cross Stitch Program
• Includes the BERNINA® Quilter Program
• Includes the PhotoSnap Program
• Can use the Reader/Writer Box and Personal Design Cards
• Can use Magic Box Plus and artista Magic Card, and/or USB PC Card Reader and artista 200E/730E
  Personal Design Card, and/or BERNINA® USB stick

Designer Plus v4.0
Explore the complete world of embroidery software including hand-look Craft Stitches, Auto-Applique, Auto-Digitizing & Manual Digitizing tools
• For the user that wishes to create (digitize) original embroidery designs
• For the user that wishes to customize and edit designs and lettering
• For users wishing to work with designs from cards, disks, CDs, USB sticks, and/or designs downloaded from Internet
• For the user that wishes to create (digitize) designs automatically
• For the user that wants complete control and digitizing flexibility
• Includes the Cross Stitch, PhotoSnap, and BERNINA® Quilter Programs
• Can use the Reader/Writer Box and Personal Design Cards
• Can use Magic Box Plus and artista Magic Card, and/or USB PC Card Reader and artista 200E/730E
  Personal Design Card, and/or BERNINA® USB stick
Getting Started

**artista & aurora Embroidery Module Set Up**

- Turn machine OFF
  (Note: **artista** 630E/640E/730E ONLY may start with machine ON)
- Module Connection Cable
  - Stored on the bottom back edge of the module
  - Make sure the FLAT side of the cable plug is to the FRONT
- Attaching the Module
  - Place the machine on a flat surface (such as a table or countertop)
  - Place the module on the machine behind the free arm
  - Slide module on from left until lugs engage in base plate
- Removing Module
  - Turn machine OFF
    (Note: **artista** 630E/640E/730E ONLY may leave machine ON)
  - Remove cable plug from sewing/embroidery computer
  - Lift module slightly (do NOT lift using the embroidery arm!) and slide the module to the left

**Prepare for Embroidery**

- Presser Foot
  - Attach Embroidery Foot #15 or #26 to the machine (**artista** & **aurora** only)
- Needles
  - Use the proper needle for the thread and fabric being used
  - Insert a new needle at the beginning of each project
  - Needle should be in the highest position when attaching the hoop to prevent snagging fabric and/or bending needle
- Straight Stitch Plate (optional accessory for **artista** & **aurora**)
  - Reduces flagging of fabric, resulting in improved stitching
- Bobbin
  - Use the Embroidery (gold latch) Bobbin Case (**artista** 640E & 730E), threading the “pigtail” for increased bobbin thread tension
  - Thread the “finger” of the bobbincase (**artista** 630E & **aurora** 430E & 440E) for increased bobbin thread tension
Threading

• Thread machine with the presser foot up (this releases tension)
• Thread using either the horizontal or vertical spool pin with the foam pad attached
  - Horizontal spool pin is for use with cross-wound threads
    - match disc size to end of spool
    - smallest disc fits into the end of large cones/spools such as Isacord embroidery thread
  - Vertical spool pin is for use with stacked threads
    - also for some decorative threads (metallic threads)
    - use supplemental thread guide as needed to control problematic threads
• Use a thread net to prevent thread from forming loops which might interfere with consistent feeding of thread
• Multiple Spool Holder (optional; available for deco, artista & aurora)
  - attaches to the back of the machine
  - holds up to 13 thread spools

Hooping Fabric

• Find the center of the fabric
• Separate the embroidery hoop sections
  - Loosen the screw. It should be loose enough that fabric and stabilizer both will EASILY fit into the hoop

Note: For more information, see appropriate pages in manual
(aurora 430E & 440QEE: pages 67-68; artista 630E/640E pages 115-116; artista 730E: pages 221-222)
• Embroidery Templates
  - Use to ensure that the motif is centered in the hoop
  - Each hoop has a corresponding template
  - When inserted correctly, “BERNINA” reads left to right, right side up
  - Template surface is marked in 1cm squares
  - Each template has cut-outs to facilitate transfer of markings to fabric
  - There are finger holes to facilitate easy removal of the small and medium hoop templates
  - Included with the Large Oval and Mega hoop templates, special attachment clips facilitate easy removal
• Secure fabric/stabilizer in the hoop
  - Lay the outer hoop on a HARD, FLAT surface
  - (deco 330 only: Place so the clamp lies off the edge of the surface and the hoop lies flat.)
  - Secure stabilizer to the back of the fabric by lightly spraying stabilizer with HRFive temporary adhesive spray
  - Place fabric and stabilizer on a firm surface
  - Position template inside the inner hoop
  - Position inner hoop on fabric, aligning any markings
  - Grasping both inner hoop and fabric/stabilizer, insert them into the outer hoop, making sure that the arrows align at the edges of both the inner and outer hoops
  - DO NOT DISTORT THE FABRIC when tightening the screw on the hoop
  - Hooped fabric should be taut, but not stretched or distorted
  - Remove template before stitching

Attaching and Removing Hoop
• When attaching hoops, be sure to seat the frame securely.
• Release the clamp completely before removing the frame from the machine
Adjusting the Hoop Reference Position (*aurora & *artista* only)

- This process calibrates the needle to the center of the hoop
- Only necessary to calibrate one hoop, as the adjustment applies to all hoop sizes

**Adjusting Embroidery Hoop (EC on PC)**

*This process is only necessary if the hoop center does not correspond with the indicated hoop center of the EC on PC display.*

- place template in hoop
  *Note: *aurora* 430E/440QEE Large Oval template grid is orange*
- select attached hoop
- use arrow keys to place center of template exactly under the needle point
- press the **Shift** key (keep depressed)
- using the mouse, click on the icon that appears on the screen next to the Position Hoop icon
- the adjustment will be saved

**Adjusting Embroidery Hoop (on-screen)** (*artista* 630E/640E/730E)

- touch external Setup button.
- select the Embroidery Settings option.
- insert embroidery template into large hoop and attach hoop to module.
  *Note: *artista* 630E/640E Large Oval template grid is orange; *artista* 730E Large Oval template grid is purple.*
- touch “Check”; hoop position will be read and hoop will stop with needle over center marking of hoop template.
- if needle is not positioned directly over the center, use the positioning arrows to make adjustments.
- touch OK; hoop setting is now saved and you may touch Esc to leave this menu as well as the Setup menu.
Sewing Machine Needles

Along with thread, needles are very important to stitch formation. Many "mechanical" problems and damage to fabrics can be traced to a bent, damaged, or incorrect size or type needle. Approximately 60% of all needles are discarded at some stage of production. When selecting the correct needle for any sewing project, consider the following:

**Needle system** – 130/705H
**Needle point** – to assure proper stitch formation and avoid fabric damage
**Needle size** – smaller for lightweight fabrics; larger for heavier fabrics

If the needle is:
- **Too small** – the thread can’t stay in the groove to form a loop to be picked up by the hook point
- **Bent** – thread loop forms too far away from hook point; hook can’t enter the loop to form stitch
- **Blunt** – needle won’t pierce fabric so no thread loop forms to make a stitch

- Needles should be changed after every 1-2 hours of embroidery stitching, before stitching the outline of any design, and after every 4-6 hours of regular sewing. The needle is the most inexpensive part in your embroidery system but is one of the most crucial for getting good results and keeping your machine running well. Don’t let false economy keep you from doing what is best for your embroidery projects and your machine.

- Selected thread should fit in the groove on the front of the needle. If it isn’t protected by the groove, a needle with a larger groove should be used.

- Always make sure needles are fully inserted, as high as possible, with the flat side to the back.

---

**Needle Size Conversion Chart**

<table>
<thead>
<tr>
<th>European</th>
<th>Domestic</th>
</tr>
</thead>
<tbody>
<tr>
<td>60</td>
<td>8</td>
</tr>
<tr>
<td>70</td>
<td>10</td>
</tr>
<tr>
<td>75</td>
<td>11</td>
</tr>
<tr>
<td>80</td>
<td>12</td>
</tr>
<tr>
<td>90</td>
<td>14</td>
</tr>
<tr>
<td>100</td>
<td>16</td>
</tr>
<tr>
<td>110</td>
<td>18</td>
</tr>
<tr>
<td>120</td>
<td>19</td>
</tr>
</tbody>
</table>

**Regardless of the system, the greater the number, the larger the diameter of the needle.**

---

**Which Needle?**

Not all needles are appropriate for use in embroidery machines. As with all sewing projects, needle choice is determined by the fabric, thread, and application. For most embroidery, an Organ needle or Embroidery needle is the best choice.

Occasionally, other needles may be recommended for specially digitized techniques, such as a Wing needle heirloom embroidery.

---

**Needle “Secret” Code**

- DRI = Triple
- E = Embroidery
- J = Jeans
- L, LL, R = Leather
- M = Microtex
- MET = Metallica
- N = Topstitching/Cordonnet
- Q = Quilting
- S = Stretch
- SUK = Fine Ball Point
- SES = Medium Ball Point
- WING = Wing
- ZWI = Double
- ZWIHO = Double Wing
<table>
<thead>
<tr>
<th>Needle Type</th>
<th>Numbers</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ball Point</td>
<td>60-100</td>
<td>Has a rounded point. 70 for lingerie, nylon, jersey; 80 for T-shirt, 90 for sweatshirt fleece.</td>
</tr>
<tr>
<td>Stretch</td>
<td>70-90</td>
<td>A stretch needle has a more rounded point than a Ball Point, and a blue anti-cling coating which helps to prevent skipped stitches in knits and elastic. Sometimes used on Ultrasuede®, vinyl, and plastic.</td>
</tr>
<tr>
<td>Stretch Double</td>
<td>2.5/75</td>
<td>Two ballpoint needles on one shank; each needle has a large scarf. Used for hemming and for stitching on knit fabric.</td>
</tr>
<tr>
<td>Stretch Double</td>
<td>3.0/75</td>
<td>Two ballpoint needles on one shank; each needle has a large scarf. Used for hemming and for stitching on knit fabric.</td>
</tr>
<tr>
<td>Universal</td>
<td>60-120</td>
<td>A compromise between a sharp and a ballpoint needle; can be used on both wovens and knits. 60 – very fine batiste, 70 – broadcloth, 80 – trigger and gabardine, 90 – denim and twill, 100/110/120 – canvas.</td>
</tr>
<tr>
<td>Universal</td>
<td>1.6/70-</td>
<td>Two needles attached to one shank. Used for pintucks, hems, and decorative work.</td>
</tr>
<tr>
<td>Universal</td>
<td>8.0/100</td>
<td>Two needles attached to one shank. Used for pintucks, hems, and decorative work.</td>
</tr>
<tr>
<td>Triple (Drilling)</td>
<td>2.5/90</td>
<td>Three needles attached to one shank. Used to create mock smocking and other decorative effects.</td>
</tr>
<tr>
<td>Triple (Drilling)</td>
<td>3.0/90</td>
<td>Three needles attached to one shank. Used to create mock smocking and other decorative effects.</td>
</tr>
<tr>
<td>Jeans</td>
<td>70-110</td>
<td>Has a sharp point and a shaft that is less prone to flex. The sharpness of the needles makes it better for use on denim and woven fabrics where a clean stitch is desired.</td>
</tr>
<tr>
<td>Jeans Double</td>
<td>4.0/80</td>
<td>Two Jeans needles attached to one shank. For topstitching on denim with heavy thread; can also be used for decorative stitching with metallic thread.</td>
</tr>
<tr>
<td>Leather</td>
<td>80-100</td>
<td>Point is a sharp cutting wedge. Used for leather only. Not for vinyl or simulated leathers.</td>
</tr>
<tr>
<td>Microtex / Sharp</td>
<td></td>
<td>A sharp point with a thin shaft. Specially designed for microfiber fabrics.</td>
</tr>
<tr>
<td>Quilting</td>
<td></td>
<td>The thin, tapered point of this needle causes less damage to fabric when seaming and cross seaming.</td>
</tr>
<tr>
<td>Topstitch</td>
<td></td>
<td>A sharp point with a large eye and deep groove. For use with heavier fabrics – the large groove cradles heavier threads.</td>
</tr>
<tr>
<td>Embroidery</td>
<td></td>
<td>Sharp needle with a large eye and groove; also has a coating and a larger scarf. For use with embroidery thread – prevents shredding of rayon or metallic threads. Two threads may be used through the eye.</td>
</tr>
<tr>
<td>Embroidery</td>
<td></td>
<td>Two Embroidery needles attached to one shaft; for double needle work with embroidery threads.</td>
</tr>
<tr>
<td>Embroidery</td>
<td></td>
<td>Similar to Embroidery needle, with large eye and deep groove, but made of a special heat-resistant alloy and with a friction-reducing coating. Especially suitable for manufactured fibers such as polyester, acrylic, nylon.</td>
</tr>
<tr>
<td>Wing</td>
<td></td>
<td>Sharp pointed needle with a non-cutting wedge of metal on each side. Makes a hole in the fabric without cutting the threads of the fabric. Used for decorative and heirloom work, such as hemstitching. Works best on natural fibers or on the bias.</td>
</tr>
<tr>
<td>Wing</td>
<td></td>
<td>One regular needle and one wing needle attached to a single shaft. Makes one large and one regular hole.</td>
</tr>
<tr>
<td>Metallica</td>
<td></td>
<td>Designed for use with metallic threads; has a large eye and deep groove.</td>
</tr>
<tr>
<td>Metallica Double</td>
<td></td>
<td>Two Metallica points on one shaft.</td>
</tr>
</tbody>
</table>
Thread

Poor quality or the wrong type of thread can cause poor stitches on any machine. Thread passes through the eye of the needle approximately 37 times in a “seesaw” action before it forms a single stitch. Poor quality thread results in crooked and looped stitches, uneven fills, misaligned outlines, frayed thread, and/or needle breakage. To achieve quality stitches, an embroidery machine needs five things: correct thread, correct stabilizer, correct hooping, correct needle, and properly adjusted thread tensions.

Several factors such as the fiber, twist, ply, finish, and size of thread must be considered for use with today’s fabrics for fine stitches.

**Staple** – refers to the length of fibers used to twist together to form a single ply. Domestic thread fiber lengths are usually 1½” to 2½” long while European threads use 5½” to 6½” lengths.

**Ply** – number of strands twisted together to make a single thread.

**Roll** – the tendency of thread to roll to the right or left during stitching, causing the stitch to appear slightly crooked. Poor quality threads are more likely to roll.

**Twist** – the crimping of fibers which causes them to interlock firmly into a single ply. Thread should not untwist during stitching. This will cause skipped stitches, thread breakage, crooked stitches, and weak spots in seams.

*Right twist* – most American threads are twisted to the right, causing some rolling. This gives average stitch quality.

*Left twist* – Most commercial and imported threads are twisted to the left, giving better than average stitch quality. Left twist resists rolling and makes a larger loop for the hook point to enter, reducing skipped stitches.
Embroidery Thread

The popularity of embroidery and wearable art embellishments has necessitated the creation and marketing of many new thread types, such as shiny polyesters, rayons and metalics. High quality threads made in West Germany generally have a left twist; Mettler and Isacord threads are also left twist. To test the twist of a thread: while holding the spool in the left hand, roll the strand of thread towards you with one thumb. Left twist will tighten, right twist will loosen.

Fiber – refers to the type of material used to produce the thread. Some commonly used embroidery and embellishment threads:

• Polyester 2 ply embroidery thread – Isacord and Polysheen embroidery thread – excellent for embroidery, very abrasion resistant. Recently made available in variegated colorways.

• Acrylic embroidery thread – excellent for embroidery. Abrasion resistant. Available in variegated colors.

• Cotton 2 ply embroidery thread – such as Mettler 60/2 – excellent for French Machine Sewing, delicate machine embroidery, piecing and darning. Has a matte finish with a slight sheen.

• Cotton 2 ply embroidery thread – such as Mettler 30/2 – loose twist for a soft, shiny look in machine embroidery, applique, and buttonholes. Thicker than most embroidery threads, 30 weight cotton may require that the stitch density be decreased slightly. Available in variegated colors.

• Rayon – available in 30 and 40 weight – a lustrous embroidery thread. Weaker than cotton, it is used for decorative work only. Available in variegated colors.

Thread Storage
Thread does wear out and deteriorate with age; it should be stored with care to keep it usable as long as possible. Extreme moisture may cause thread to swell while very dry conditions can leave it dry and brittle as it ages. Store thread in a covered place (thread box with a lid, cabinet with doors, or drawers that close) if possible to keep it dust-free.

Be wary of old spools of thread recovered from Grandma’s sewing box. The fibers may be so weak and brittle that even if it sews without breaking, it may be so unstable that the garment or project will not hold together and the life of the project may be considerably shortened.
Stabilizers & Interfacings

**Tear-Away Stabilizer:** The most commonly used type of stabilizer, designed to provide *temporary* support of stitching. Placed on the wrong side of the project and carefully pulled away once stitching is complete. Available in three weights – heavy, medium, and light. Multiple lightweight layers may be preferable to one heavy layer, as they are easier to remove. The Hydro-Stick version, available in lightweight and heavyweight tear-away, has water-activated adhesive on one side for a secure bond and a high degree of stabilization for very dense and/or intricate designs. Also available: Smooth Touch Tear-Away, Ultra Clean & Tear.

**Cut-Away Stabilizer:** The most widely used stabilizer in the commercial market. Does not break down under dense stitching, due to the high fiber – rather than paper – content. Excess stabilizer is trimmed away after stitching (leave approximately ¼” of stabilizer around the edges). A Hydro-Stick version of heavyweight cut-away is also available.

**Web/Poly-Mesh Type Stabilizer:** A specially formulated cut-away stabilizer developed for use behind lightweight or light-colored fabrics. Available in fusible or non-fusible versions.

**Water-Soluble Stabilizer:** Used for backing and topping, in single or multiple layers. Available in several weights: Aqua Film Universal Weight, Aqua Film Extra Weight, Badgemaster (very heavy), and Aqua Mesh Wash Away. Excellent for decorative stitching and cutwork as there are no remnants of stabilizer left after removal (it dissolves). As a topping, it keeps stitches from being lost in heavily napped fabrics such as velvet and corduroy.

**Iron-On Tear-Away Stabilizer:** A non-woven product similar to paper. Perfect for knits, this tear-away stabilizer is temporarily bonded to the fabric, inhibiting the tendency of the material to stretch.

**Heat Removable Stabilizer:** Woven from strands of fiber that are burned away at a low temperature, heat removable stabilizers are perfect for heirloom stitchery.

**Liquid/Spray Stabilizers:** Wonderful for sheer fabrics from which all stabilizer must be removed after stitching, these products are painted or sprayed onto the fabric. Several light applications are preferable to one heavy layer.
Knit Fusible Interfacing: A very lightweight, flexible interfacing sometimes used in addition to or instead of a stabilizer, it gives permanent support (as an underlining) to a fabric. Perfect for plackets, garment edges, under buttonholes, and anywhere extra body and stability are needed. Can also be used to stabilize decorative stitch work.

Woven Fusible Interfacing: This interfacing is sometimes used in addition to or instead of a stabilizer, it gives permanent support (as an underlining) to a fabric. Generally cut on the bias to provide better drape. Gives a firmer hand or finish than knit or non-woven interfacings. Used for lapels, facings, and anywhere a great deal of extra body and stability are needed.

Sewing & Craft Sprays

HRFive Temporary Adhesive Spray: It’s water-soluble, so it washes out completely. Great for basting or holding two layers of fabric and/or batting together. Can be used as a repositionable spray, allowing items to stay sticky but be repositioned on other surfaces. This water-soluble adhesive washes out completely. Works well for securing “hard-to-hoop” items such as collars and cuffs to hooped stabilizer for embroidering. Also works on paper, and can be used as a no-show adhesive on vellum.

606 Fusible Spray: 606 is used to make any fabric or stabilizer fusible. Apply to the wrong side of the fabric to be fused, using several light coats, rather than one heavy coating. The more coats used, the stronger the bond will be. Fuse as directed on label.

Fabric Shield: Used to protect fabrics from dust, dirt, grease, and oil, this spray is water repellent and can be laundered and dry-cleaned.

HRZero Adhesive Remover Spray: For removing adhesives, such as quilt sprays and other spray adhesives, in addition to label and tapes from various surfaces. Use on work surface areas, hoops, needles, frames, quilting frames, stencils, table tops, etc. For use on plastic, metal, wood, glass, stone, and ceramic surfaces. Not intended for fabric surfaces.
Stitching A Motif

deco 330
Select indicated motif.

Stitch. **Note:** *At the end of each color, the machine automatically stops and a message appears reminding you to cut the thread and rethread for the next color.*

When the motif is complete, a message appears indicating that the stitching is finished.

Press the carriage return key after finishing the last section to return the carriage to the stored position.

aurora 430E & 440QEE
Select and open indicated motif. Click on Write to Machine icon. Select *aurora* 430/440 (stitch out only); EC on PC opens. **Note:** *Make sure feed dog is lowered, presser foot is up, and foot control is removed.*

Attach hoop. Click on the module arm graphic to calibrate the module.

Click on start button on EC on PC screen. Hoop moves, then an animation prompts you to lower the presser foot and press the Start/Stop button on the machine.

Machine will sew a few stitches and stop. An animation appears, prompting you to trim thread tail. When first color is complete, animation will prompt you to change the thread to the next color.

When embroidery is complete, ✓ appears in lower left corner of EC on PC screen. Trim and mount sample.

artista 630E & 640E
Select the sewing machine icon and motifs (butterfly) folder to access the stored embroidery designs.

Select indicated design; stitch.

630E: **At the end of each color, the machine automatically stops and a message appears reminding you to cut the thread and rethread for the next color.**

640E: **At the end of color one, the thread is automatically cut and a message appears reminding you to thread the next color.**

When motif is complete, an OK appears on screen to indicate that stitching is finished.

artista 730E
Select the sewing machine icon and motifs (butterfly) folder to access the stored embroidery designs.

Select indicated design. Touch OK to go to Embroidery Ready screen.

Stitch. **Note:** *At the end of each color, thread is automatically cut and a message appears reminding you to thread the next color.*

When the motif is complete, a message will appear indicating that the stitching is finished.

Embroidery Motif
deco 330
#36 - floral swag

aurora 430E & 440QEE
My Designs > Floral3.art

artista 630E & 640E
#17 - floral heart

artista 730E
#5 - floral wreath

Fabric & Stabilizer
8” x 10” rectangle
Stitching A Motif Sample

deco 330

aurora 430E & 440QEE

e & 640E

artista 730E
Monochrome Embroidery

**deco 330**
*Note: To achieve the same effect on the deco 330, use the same thread color for all color changes.*

**aurora 430E & 440QEE**
Select Mono/Multicolor icon (paintbrush icon). When engaged, the entire design will stitch without stopping for color changes.

Click EC on PC start button; lower presser foot and press the Start/Stop button on the machine. The complete motif will be embroidered without stopping.

When stitching is complete, a ✓ appears in the lower left corner of the EC on PC screen.

Trim and mount sample.

**artista 630E & 640E**
Touch OK to go to Embroidery Ready screen.

Select the Single/Multi color motif symbol (paintbrush icon).

With this function engaged, the entire motif will be completed in one color with no stops or thread cuts.

Stitch.

**artista 730E**
Touch OK to go to Embroidery Ready screen.

Select the Single/Multi color motif symbol (paintbrush icon).

With this function engaged, the entire motif will be completed in one color with no stops or thread cuts.

Stitch.

**Embroidery Motif**
- **deco 330**
  - #36 - floral swag
- **aurora 430E & 440QEE**
  - My Designs > Floral3.art
- **artista 630E & 640E**
  - 630E: #14 - floral heart
  - 640E: #17 - floral heart
- **artista 730E**
  - #5 - floral wreath

**Fabric & Stabilizer**
- 8” x 10” rectangle
Monochrome Embroidery Sample

*dec* 330

*aurora* 430E & 440QEE

*artista* 630E & 640E

*artista* 730E
Customizing Thread Color

**Deco 330**

- **Aurora 430E & 440QEE**
  - Select Settings > Thread Colors > Isacord 40wt-shades.
  - Click on Color 1 in top panel of dialog box; scroll through colors in lower panel of dialog box.
  - Select color 5934; click Assign.
  - Select Color 2 from top panel.
  - Type 2250 in the Search field.
  - Click Assign. Click OK.
  - Select File > Save As. Type **thread color exercise** in the File Name field. Click Save.
  - **Note:** Using Save As preserves your original design file.
  - Send to **Aurora** to embroider the newly colored design.
  - Trim and mount sample.

**Artista 630E, 640E, 730E**

Hoop fabric and stabilizer in Medium hoop.

Select floral motif again. It opens in the Edit 1 screen. Touch the Color Number icon in lower left corner of screen; Color Motif display appears.

Touch the Color Information bar. A dialog box opens with Change thread color/brand information. In this box, the current thread color and/or brand of thread can be changed.

Select a brand of thread, selecting from Isacord, Madeira, Mettler Silky Sheen, Sulky, and Mettler Poly Sheen. Assign a new shade of green to the design and touch OK.

Edit 1 screen reappears. Use right hand scroll arrow to move to second color; touch Color Information Bar. Repeat process changing the color of the flowers.

Repeat a third time and change the color of the flower centers.

Embroider your newly colored design. If you wanted, this customized motif could be saved with your new color settings for later use. (Saving Motifs will be covered on page 44, Saving & Deleting Embroidery Motifs.)

Trim and mount the sample.
Customizing Thread Color Sample

- *deco 330*
- *aurora 430E & 440QEE*
- *n/a*

- *artista 630E & 640E*
- *artista 730E*
Duplicating & Rescaling Motifs
(aurora 430E/440QEE & artista 630E/640E/730E only)

aurora 430E & 440QEE
Connect aurora to PC following instructions in owner’s manual.
Select File>Open from main menu. From My Designs folder, select Floral5.art. Open. Choose Select Object tool; click on design to select it.
Select Edit>Duplicate from main menu. There are now 2 embroidery motifs on screen. While duplicate is selected, click & drag it to left. Note: When designs are duplicates or pasted, the new design is placed in the location from which it was copied.
Right click to open Object Properties dialog box. Type 180 in width and height fields. Click OK.
Select File>Save As. Type duplication exercise in File Name field. Click Save. Note: Using the Save As function preserves your original design file.
Send design to aurora for embroidery. Trim and mount sample.

artista 630E & 640E:
Hoop fabric and stabilizer in Large Oval Hoop.
Select indicated motif; it opens in Edit 1. Select Add Motif icon; reselect the same design. There are now two copies of motif on screen; the first one is gray and the second one - on top - is in color. The color motif is the active one.
Touch the To Next Page - Edit 2 symbol. Touch the Move Motif symbol and move the active motif toward top of hoop. Note: It may be necesssary to select the Large Oval hoop.
Using the Retrieve function, activate the other motif and move it toward the lower end of the hoop.
Touch Rescale Motif Proportionally icon; increase lower motif size to 160%. Touch OK.
Embroider motif. When stitching is complete, trim and mount sample. Note the design stitch count for later reference.

artista 730E:
Hoop fabric & stabilizer in Large Oval Hoop.
Select indicated motif; it opens in Edit 1 screen. Select Duplicate Motif symbol. There are now 2 copies of motif on screen. The 1st one is gray and the top one is in color. The color motif is the active one.
Touch the To Next Page - Edit 2 symbol. Touch Move Motif symbol; move active motif toward top of hoop.
Using Retrieve function, activate other motif; move toward lower end of hoop.
Touch Rescale Motif Proportionally icon; increase lower motif size to 180%; OK.
Dialog box asks if you wish to recalculate stitch count or simply resize motif without recalculating stitch density. Select “recalculate” option. Note: “resize” simply takes existing design and spreads stitches to fit new size parameters of design.
Embroider motif. When complete, trim and mount sample. Note stitch count of design for later reference.

Embroidery Motif
deco 330
n/a
artista 430E & 440QEE
My Designs > Floral5.art
artista 630E & 640E
630E: #13 - floral
640E: #19 - floral
artista 730E
#4 - daisy
Fabric & Stabilizer
8” x 10” rectangle

Notes
Note: With Editor Lite you can use menu commands or toolbar icons to access features and functions.
Duplicating & Rescaling Motifs Sample

*deco 330*

n/a

*aurora 430E & 440QEE*

*artista 630E & 640E*

*artista 730E*
Proportional Resizing of Motifs
(*artista* 730E only)

*artista 730E only*

Hoop fabric & stabilizer in Large Oval Hoop. Open a New file.

Select the motif used in the previous exercise. Select the Duplicate Motif symbol.

Touch the To Next Page - Edit 2 symbol. Touch the Move Motif symbol; move active motif toward top of hoop. Using the Retrieve function, activate the other motif; move it toward the lower end of the hoop.

Touch the Rescale Motif Proportionally; increase the lower motif size to 180%. Touch OK. The dialog box opens asking if you wish to recalculate the stitch count or simply resize the motif. This time, select the “resize” option.

Embroider the resized motif. When the motif is complete, trim and mount the sample. Note the stitch count of the design for later reference.

Notice the dramatic difference between the “resized” sample and the “recalculated” sample from the previous exercise. Your *artista* 730E added stitches to the “recalculated” motif to make the daisy motif look as nice as the original.
### Proportional Resizing of Motifs Sample

<table>
<thead>
<tr>
<th>Logo</th>
<th>Model(s)</th>
<th>Proportional Resizing of Motifs Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>deco</td>
<td>330</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>aurora</td>
<td>430E &amp; 440QEE</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>artista</td>
<td>630E &amp; 640E</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>artista</td>
<td>730E</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Rotating Designs

decco 330
The deco 330 rotates designs in clockwise increments of 45° (1x = 45°, 2x = 90°, 3x = 135°,...)

Select indicated motif. Select Editing tab. Use positioning arrows or touch screen to move the motif up and to the right.

Select Pattern selection tab. Select motif again. Touch Rotate 45°. Move design to right.

Select Pattern selection tab. Select motif again. Touch Rotate 45° two times. Move design to left and down.

Embroider. Press carriage return key after finishing last section to return carriage to stored position.

Trim sample, then mount it on the following page.

aurora 430E & 440QEE
Editor Lite software provides quick & easy rotation by 45° increments, free rotation by clicking & dragging, and by specifying degree of rotation in the Object Properties box.

Select motif; copy; paste. Right click to open new design’s Object Properties > General. Type 22 in Rotation field; click OK. Move design up and to the right.

Click Paste; while selected, rotate design 45° by left clicking Rotate CCW/CW icon. Move up & to right.

Click Paste; right click to open Object Properties > General. Type 77 in Rotation field; OK. Move up and to the right.

Paste again; left click 2x on Rotate CCW/CW icon. Move up & to right.

Save As rotation exercise. Send to machine. Stitch, trim, mount.

artista 730E
The artista 730E rotates designs in clockwise and counterclockwise increments of 1°.

Select motif. Select Edit 2. Using Stitch Length and Width knobs, move design to upper right corner of hoop.

Go to Edit 1 > Add Motif. Select same motif again. Go to Edit 2; select Rotation icon; rotate design 22°. Move motif up and slightly to the left.

Continue adding motifs, rotating to 45°, 70°, and 90°. Using the Retrieve function, arrange as shown. Touch OK.

Embroider and trim sample, then mount it on the following page.

artista 630E & 640E
The artista 630E & 640E rotate designs in clockwise & counterclockwise increments of 1°.

Select motif; it opens in Edit 1. Select Large Oval hoop. Select Edit 2; move design to upper right corner of hoop.

Go to Edit 1 > Add Motif. Select same motif again. Go to Edit 2; select Rotation icon; rotate design 22°. Move motif up and slightly to the left.

Continue adding motifs, rotating to 45°, 70°, and 90°. Using the Retrieve function, arrange as shown. Touch OK.

Embroider and trim sample, then mount it on the following page.

Embroidery Motif
decco 330
#35 - floral border

aurora 430E & 440QEE
My Designs > BlackBorder2.art

artista 630E & 640E
630E: #21 - floral
640E: #27 - floral

artista 730E
#14 - little wild rose

Fabric & Stabilizer
8” x 10” rectangle

Notes

Note: Editor Lite software provides quick and easy rotation – 45° increments by clicking on Rotate CCW/CW icon, free rotation by clicking and dragging, and by a specific degree of rotation in the Object Properties box.
Rotating Designs Sample

deco 330

aurora 430E & 440QEE

artista 630E & 640E

artista 730E
Proportional Resizing/Rescaling & Rotation

**deco 330**
*deco 330 designs can be resized in increments of 10%, from 90-120%.*

Select indicated motif. Select Editing tab. Select Resize key. Touch the minus (-) key one time. Touch OK. Touch Rotate 45° one time. Use the positioning arrows or the touch screen to move design up and to the right.

Select Pattern selection tab. Select the motif again. Move to lower left. Touch Resize key. Touch the plus (+) key two times. Touch OK; touch OK.

Embroider. Press the carriage return key after finishing the last section to return the carriage to the stored position.

Trim and mount the sample.

**aurora 430E & 440QEE**
*Select motif. Select Edit > Duplicate. There are now 2 embroidery motifs on screen. While selected, click & drag duplicate to the right. Note: When designs are pasted, duplicates are placed in location from which they were copied.*

Click and drag a black corner sizing handle toward center of motif. This proportionally scales down the motif.

Left click on selected motif; the corner handles open (turn clear). Click and drag one corner rotation handle to rotate design freely.

Position motifs in a pleasing arrangement.

Save As proportional rescaling and rotation exercise.

Stitch, trim, and mount sample.

**Notes**

**artista 630E & 640E**
*Select motif; it opens in Edit 1. Select Large Oval hoop. Select Add Motif and reselect design. There are now 2 copies on screen; the one in color is active.*

Go to Edit 2. Touch Rescale Motif Proportionally icon; decrease size of active motif to 70%. Touch Move Motif; move toward top of hoop.

Touch Retrieve until only larger motif is active. Touch Move Motif; rotate counterclockwise until symbol reads -32°. *Note: Items can be rotated 1° at a time or in 90° increments.*

Retrieve only smaller motif; rotate clockwise to 16°. Using Move Motif; move designs to a pleasing central arrangement. Touch OK.

Embroider. Trim & mount sample.

**artista 730E**
*Select indicated motif; it opens in Edit 1. Select Large Oval Hoop.*

Select Duplicate Motif symbol; there are now 2 copies of motif on screen (color motif is active).

Go to Edit 2. Touch Rescale Motif Proportionally; decrease active motif size to 70%. Touch Move Motif; move motif toward top of hoop.

Touch Retrieve until only large motif is active. Touch Move Motif; move large motif toward bottom of hoop. Select Rotate. Rotation can be done 1° at a time or in 90° increments. Rotate large motif CCW to -32°. Retrieve smaller motif; rotate CW to +16°. Using Move Motif option, create a pleasing arrangement; touch OK.

Choose the Recalculation option. When processing is complete, embroider. Trim and mount the sample.

**Embroidery Motif deco 330 #15 - butterfly**

**aurora 430E & 440QEE**
*My Designs > flower.art*

**artista 630E & 640E #1 - butterfly**

**artista 730E #2 - butterfly**

**Fabric & Stabilizer**
*8” x 10” rectangle*
Proportional Resizing/Rescaling & Rotation Sample

**deco 330**

**aurora 430E & 440QEE**

**artista 630E & 640E**

**artista 730E**
Stretching Designs
(\textit{aurora} \& \textit{artista} 730E only)

The height and width of objects can be changed independently, allowing items to be made tall and thin and/or short and wide.

\textbf{aurora 430E \& 440QEE}

Open a New design file.

Left click on the Lettering icon. Click in the middle of the hoop to begin text. Type \textit{B}; press Enter on the keyboard. Click on one of the corner sizing handles to rescale the letter.

Select letter. Select Edit > Duplicate; move duplicate down and to the right. Click & drag top center sizing handle to alter letter height.

Click on Paste icon; move new duplicate down and to the right. Click and drag left center sizing handle to alter letter width.

Reposition letters as needed to form a pleasing arrangement.

Save As \textit{stretching exercise}; click Save.

Embroider, trim, mount sample.

\textbf{artista 730E}

Select indicated motif.

Touch the Duplicate icon to copy the design. Touch Edit 2; select the Adjust Height/Width icon. Increase the height of the active motif to 140%. Move the motif to the upper right corner.

Duplicate the design again. Touch Edit 2; return the height of the active motif to 100%, then increase the width to 140%. Move the motif to the lower left corner. Touch OK to process design.

Embroider and trim sample, then mount it on the following page.
Stretching Designs Sample

- deco 330
- n/a
- aurora 430E & 440QEE

- artista 630E & 640E
- n/a
- artista 730E

©2006 BERNINA® of America, Inc. Permission to copy granted only to Authorized BERNINA® Dealers
Right-to-Left Mirror Image

**deco 330**
Right/Left Mirror Image
Select the indicated motif. Select the Editing tab. Use the positioning arrows to move the motif to the left.

Select Pattern selection tab. Select motif again. Touch the Right/Left Mirror Image icon. Use the positioning arrows to move motif to the right.

Embroider. Press the carriage return key after finishing the last section to return the carriage to the stored position.

Trim; mount the sample on the following page.

**aurora 430E & 440QEE**
Right/Left Mirror Image
Select the indicated motif.

Left click on the Scale By 20% icon to scale the motif down 20%.

Select Edit>Duplicate; there are now two motifs on screen. Click on Mirror Image Right/Left to mirror image motif.

While duplicate is selected, use the left arrow keyboard key to move design to left. *Note: Use up or down arrows to move design along its vertical axis, and/or right and left arrows to move design along its horizontal axis.*

Save As right-left mirror image exercise.
Embroider, trim, mount sample.

**artista 630E & 640E**
Right/Left Mirror Image
Select indicated motif. In Edit 1, select the Medium hoop. Select the Add Motif symbol and reselect the indicated motif. There are now two motifs on the screen.

Go to Edit 2. Touch the Right/Left Mirror Image symbol. The active motif is flipped. Move it to the left side of the hoop.

Retrieve the other motif and move it to the right side of the hoop. Touch OK.

Use the Retrieve icon to activate both motifs. Select the rescale function & decrease size to 75%.

Stitch, trim and mount sample.

**artista 730E**
Right/Left Mirror Image
Select indicated motif. In Edit 1, select the Medium hoop. Select Duplicate Motif symbol. There are now two motifs on the screen.

Go to Edit 2. Touch the Right/Left Mirror Image symbol. The active motif is flipped. Move it to the left side of the hoop.

Retrieve the other motif and move it to the right side of the hoop. Touch OK.

Use the Retrieve icon to activate both motifs. Select the rescale function & decrease size to 75%.

Stitch, trim and mount sample.

Embroidery Motif
*deco 330*
#14 - seahorse

*aurora 430E & 440QEE*
My Designs > Floral1.art

*artista 630E & 640E*
#19 - flowers
#25 - flowers

*artista 730E*
#8 - grape leaf

Fabric & Stabilizer
8" x 10" rectangle
Right-to-Left Mirror Image Sample

deco 330

aurora 430E & 440QEE

artista 630E & 640E

artista 730E
Up-to-Down Mirror Image
(deco 330, aurora & artista 730E only)

**deco 330**
Up/Down Mirror Image
Select indicated motif. Select Editing tab. Use the positioning arrows to move the motif down.

Select Pattern selection tab. Select motif again. Touch the Up/Down Mirror Image icon. Use the positioning arrows to move the motif up.

Embroider. Press the carriage return after finishing the last section to return the carriage to the stored position.

Trim; mount on following page.

**aurora 430E & 440QEE**
Up/Down Mirror Image
Select indicated motif.
Left click on the Scale By 20% icon to scale the motif down 20%.
Select Edit>Duplicate from the main menu. There are now two embroidery motifs on the screen.
While duplicate is selected, click & drag it toward bottom of hoop.
Click on the Mirror Image Up/Down icon to mirror image the motif.
Save As up-downl mirror image exercise.

Stitch, trim, and mount sample.

**artista 630E & 640E**
Up/Down Mirror Image
n/a

**artista 730E**
Up/Down Mirror Image
Select the indicated motif.
In Edit 1, select the Medium hoop.
Select Duplicate Motif symbol. There are now two copies of the motif on the screen.
Go to Edit 2. Touch the Up/Down Mirror Image symbol. The active motif is flipped. Move it to the lower end of the hoop.
Retrieve the other motif and move it to the upper end of the hoop. Touch OK.
Stitch, trim and mount sample.

**Embroidery Motif**
**deco 330**
#19 - fancy border

**aurora 430E & 440QEE**
My Designs > Floral8.art

**artista 630E & 640E**
n/a

**artista 730E**
#14 - little wild rose

**Fabric & Stabilizer**
8" x 10" rectangle

Notes
Up-to-Down Mirror Image Sample

- **deco 330**
- **aurora 430E & 440QEE**
- **artista 630E & 640E**
- **artista 730E**
- n/a
Using Embroidery Cards

**deco 330**
Insert desired embroidery card into slot on right side of embroidery machine. Select Design Card tab. Scroll through designs and select desired motif.

Embroider and trim sample. Press the carriage return key after finishing the last section to return the carriage to the stored position.

Trim and mount sample.

**aurora 430E & 440QEE**
Embroidery collections on cards may be accessed using the Mini Magic Box Plus or Magic Box Plus and sent directly to the machine using EC on PC.

Stitch, trim, and mount sample.

**artista 630E & 640E**
Embroidery collections on cards may be accessed using the Mini Magic Box Plus or Magic Box Plus and sent directly to the machine for stitching, or written to a BERNINA® Personal Design Stick for use in the machine.

Stitch, trim, and mount sample.

**artista 730E**
Insert desired embroidery card into slot on right side of sewing machine.

Touch embroidery card icon (teddy bear) motif. Select desired motif.

Stitch, trim, and mount sample.

**Embroidery Motif**
**deco 330**
any card design
(sample: Studio BERNINA® Fun with Bears by Mary Ann June Collection)

**aurora 430E & 440QEE**
any card design
(sample: Studio BERNINA® Dena’s Closet Crafter’s Collection)

**artista 630E & 640E**
any card design
(sample: Studio BERNINA® Floral Inspirations by Debbie Mumm Collection)

**artista 730E**
any card design
(sample: Studio BERNINA® Fuzzytails by Lisa McCue Collection)
Using Embroidery Cards Sample

Deco 330

Aurora 430E & 440QEE

Artista 630E & 640E

Artista 730E
Using an Embroidery CD or BERNINA® or OESD USB Stick

**deco 330**

- **aurora 430E & 440QEE**
  - Embroidery collections on CDs and BERNINA® or OESD USB Sticks may be accessed through the Editor Lite Embroidery Software; simply select the CD or USB Stick drive instead of the My Designs folder.

  - Select Girl Bear. Select Insert Design; select Boy Bear. Position within hoop as desired.

  - Stitch, trim, and mount sample.

**artista 630E & 640E**

- Embroidery collections on CDs and BERNINA® or OESD USB Sticks may be accessed through the Editor Lite Embroidery Software; simply select the CD or USB Stick drive instead of the My Designs folder.

  - Select Iris. Select Add Design and insert Iris text. Position within hoop as desired.

  - Stitch, trim, and mount sample.

- **artista 730E**
  - **CDs: Optional CD Drive required**
  - Connect BERNINA® CD Reader to artista.

  - **USB Sticks: Use USB port in right side of artista 730.**

  - Insert CD or BERNINA® or OESD USB Stick; select Seasonal Designs icon. Select #42-Violets. Touch Add Motif button. Select #41-Bleeding Heart.

  - Select Edit 2. Select Move Motif symbol; move Bleeding Heart to left of Violets.

  - Select Edit 1; select Duplicate icon. Select Edit 2: touch Right/Left Mirror Image to reverse duplicated Bleeding Heart. Move it to the right.

  - Touch Retrieve icon until all three flowers are selected. Rotate grouping 90º by touching Rotation symbol two times. Touch OK.

  - Embroider, trim, and mount sample.

  - Note: Designs may also be accessed using any level of BERNINA® Embroidery Software, including Editor Lite.

**Notes**

**artista 730 CD Reader**

- Microsoft® CE.NET gives the artista 730 the ability to have both a USB client port and a USB host port.

**Client Port**

- Enables your artista 730E to receive instructions from your PC and BERNINA® embroidery software.

**Host Port**

- Allows the artista 730E to give direction to a peripheral such as the BERNINA® CD-R drive and retrieve .ART files from BERNINA® design CDs and OESD multi-format design collection CDs.

**Embroidery Motif**

- **deco 330**
  - n/a

- **aurora 430E & 440QEE**
  - any CD or USB Design Stick design (sample: Sue Dreamer Collection, Girl Bear & Boy Bear)

- **artista 630E & 640E**
  - any CD or USB Design Stick design (sample: Tuscan Memories by Louise Max Collection, Iris & Iris text)

- **artista 730E**
  - any CD or USB Design Stick design (sample: artista 730E design CD or USB Stick, Violets & Bleeding Heart)
CD or USB Stick Sample

- **deco 330**
- **aurora 430E & 440QEE**
- **n/a**

- **artista 630E & 640E**
- **artista 730E**

Sample designs include an iris and a bear and doll.
Saving & Deleting Embroidery Motifs

After customizing an embroidery motif or creating a combination that you want to be able to quickly access and use again, follow these steps. (For these exercises, use the combination from the previous exercise.)

deco 330
Saving a Motif to Machine
Select Editing tab. Touch Save File Key. Touch File Name key to assign file name. Key in file name. Touch OK; touch OK.

Saving to a Personal Design Card
Select Editing; touch Save File. Touch Built in/Card key to toggle to Personal Design Card. Touch File Name key to assign file name. Key in file name. Touch OK; touch OK.

Deleting a Motif
Select Editing tab. Touch Delete key symbol (trash can).

Retrieving a Saved Motif
Select Pattern selection tab. Select Open File key. Touch Built in/Card key to toggle between Built in motifs and motifs on the PDC. Use arrow keys to select desired motif. Touch OK.

aurora 430E & 440QEE
Saving a Motif
Select File > Save As. Save in desired location (My Designs folder or other location).

Note: Motifs are accessed through the Editor Lite software on your PC.

Formatting the Personal Design Card (deco 330 only)
Formatting the Personal Design Card (PDC) enables designs to be saved and transferred from the PC to the deco 330. Note: The deco 330 will only read expanded (.exp) format designs.

Insert the PDC into the slot on the side of the deco 330. Select the Mode key. Select Set Up and page forward until “Format Card” appears. Touch “Format Card”. Note: All designs previously saved to PDC will be erased.

If using BERNINA® embroidery software, the card will automatically be formatted when a design is written to the PDC, and the design will automatically be converted to .exp format. Note: All designs previously saved to PDC will remain on the card.
Saving & Deleting Embroidery Motifs

After customizing an embroidery motif or creating a combination that you want to be able to quickly access and use again, follow these steps. (For these exercises, use the combination from the previous exercise.)

**artista 630E & 640E**

**Saving a Motif**

Go to Edit 1. Select the Save icon (floppy disc). A screen appears that enables you to save your motif to the sewing/embroidery computer or Personal Design Stick.

Select the Embroidery computer symbol. Your motif combination is shown as NEW on the screen. Touch the picture of your motif. The saved combination is displayed in the Edit 1 screen.

**Deleting a Saved Motif**

Select the My Designs folder. Select the trash can. Select the motif you wish to delete. Select OK. After confirming your decision to delete the design, the design is deleted.

*Note: It is not possible to delete designs from the motif or alphabet folders, only from the My Designs folder.*

**Deleting All Saved Designs**

It is possible to delete the entire contents of a Personal Design Stick or the My Designs folder. Touch Set Up; the Selection menu appears. Touch the Reset icon. Select Delete User Data. In embroidery mode, two options are available: My Designs or Personal Design Stick (the stick must be plugged into the embroidery computer). Select desired option. Confirm the display message by touching OK. Touch Esc until the last activated embroidery screen appears.

**artista 730E**

**Saving a Motif**

Go to Edit 1. Select the Save icon (floppy disc). A screen appears that enables you to save your motif to the sewing/embroidery computer or Personal Design Card or Stick.

Select the Embroidery computer symbol. Your motif combination is shown as Untitled on the screen. Touch the picture of your motif. A “keyboard” screen appears; input a name for your creation. *Note: Upper and lower case letters are available as well as a variety of numbers and symbols.* After naming your motif, touch OK. The saved combination is displayed in the Edit 1 screen.

**Deleting a Motif**

In the Edit 1 screen, select New Motif icon. Select the My Designs folder. Select the Help symbol. Touch the embroidery motif you wish to delete. An information screen appears, listing Design Information.

Touch the Delete symbol (trash can). A Delete Design screen appears offering the option to delete ONLY the selected design or to delete the entire contents of the selected folder.

Select the Delete Design ONLY option. One more dialog box appears, asking is you are sure that you want to delete the selected motif. Confirm by selecting Yes. The motif is now deleted.
Embroidery Beginnings Shopping List

- Magic Box Plus with artista Magic Card
- Mini Magic Box Plus with artista Magic Card
- USB PC Card Reader (OESD)
- BERNINA® CD Drive (200/730 only)

- Embroidery Collections
  (Studio BERNINA® Cards & CDs,
  BERNINA® & OESD USB Design Sticks)
  - __________
  - __________
  - __________

- Stabilizers
  Cut-Away
  - Heavyweight Cut-Away
  - Xtra Heavyweight Cut-Away
  - Hydro-Stick Cut-Away
  - Cut-Away Poly-Mesh
  - Fusible Poly-Mesh
  - Stabil-Stick Cut-Away

  Tear-Away
  - Lightweight Tear-Away
  - Smooth Touch Tear-Away
  - Medium Weight Tear-Away
  - Hydro-Stick Tear-Away
  - Ultra Clean & Tear
  - Stabil-Stick Tear-Away

- Water-Soluble
  - Aqua Film Topping & Backing
  - Badge Master Wash-Away
  - Aqua Mesh Wash-Away
  - Aqua Mesh Plus (adhesive-backed)

- Other
  - Spray Starch
  - Brush/Paint-On products
  - Fusible Interfacing products
  - HRFive Temporary Spray Adhesive

- ABCs of Embroidery
- Sew Much Fun
- A Touch of Artistry I
- Seasons of Artistry
- Through the Needle magazine

- Isacord Embroidery Threads
  - color __________
  - color __________
  - color __________

- Yenmet Metallic Embroidery Threads
  - color __________
  - color __________

- Other Embroidery Threads
  - color __________
  - color __________

- Bobbin Thread

- Embroidery Needles – mixed #75/90
- Organ Embroidery Needles
  - #70/10 Sharps (#70/10, 80/12, 90/14)
  - Ballpoint (#70/10, 80/12, 90/14)

- Supplemental Thread guide
- Multiple Spool Holder
- BERNINA® Thread Box
- Clear Acrylic Embroidery Table (18” x 24”)
- Large Clear Acrylic Embroidery Table (24” x 24”)
- Suitcase System

- Embroidery Hoops
deco 330
  - Free Arm Hoop
  - Round Hoop

  aurora/artista
  - Small Embroidery Hoop
  - Freearm Embroidery Spacer
  - Medium Embroidery Hoop
  - Large Oval Hoop
  - Hoop 'N' Buddyz Hat Hoop Insert (fits Large Oval only)
  - Mega Hoop (artista 630E/640E/730E only)

- Hoop-It-All™ Hoops
  - Quilters Square Double Wide
  - Super Double Wide
deco 330 Double Wide
  - Big/Cap Hoop
Mastering Your
BERNINA®
Embroidery Module/Machine

Owner’s Workbook

Section B
Beyond the Basics
General Information:
Working with Alphabets & Text

Working with Alphabets

**deco 330**
- 3 sizes: Large - 30mm; Medium - 20mm; Small - 10mm
- 2-letter and 3-letter monograms

**aurora 430E/440QEE** - see chart
- alphabets can be resized using Editor Lite

**artista 630E/640E/730E** - see chart
- alphabets can be resized using on-screen editing functions

<table>
<thead>
<tr>
<th>Alphabet</th>
<th>deco 330</th>
<th>aurora</th>
<th>artista 630E</th>
<th>artista 640E</th>
<th>artista 730E</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alice</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>yes</td>
</tr>
<tr>
<td>Anniversary</td>
<td>--</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>--</td>
</tr>
<tr>
<td>Bamboo</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>Blackboard</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>yes</td>
</tr>
<tr>
<td>Chateau</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>yes</td>
<td>--</td>
</tr>
<tr>
<td>Cheltenham</td>
<td>yes</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>Child's Play</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>yes</td>
</tr>
<tr>
<td>Cursive</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>yes</td>
</tr>
<tr>
<td>Drifter</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>yes</td>
</tr>
<tr>
<td>Emerald</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>yes</td>
<td>--</td>
</tr>
<tr>
<td>Gothic</td>
<td>yes</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>Guinevere</td>
<td>--</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>--</td>
</tr>
<tr>
<td>King Charles</td>
<td>--</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Lisa</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>yes</td>
</tr>
<tr>
<td>London</td>
<td>--</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Script</td>
<td>yes</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>Swiss Block</td>
<td>--</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Varsity Block</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>yes</td>
</tr>
</tbody>
</table>
Selecting, Adding, & Deleting Letters

**deco 330**
*Selecting Characters*
Select the Font key. Select font style. Touch the desired letters on the “keyboard” screen. Use the A/a icon to toggle between upper and lower case letters.

*Deleting & Adding Characters*
- To delete, move cursor under the letter/character; select the Delete icon (trash can)
- To add, move cursor to the right of the desired position; select the character and touch OK

**aurora 430E & 440QEE**
Open a New file. Left click on the Lettering Values icon. *Note: Notice prompts on status line.*

Place cursor on design screen; left click; a vertical bar appears.

Type BERNANA; lettering outline appears on screen.

Press Enter; lettering is filled and selected.

While lettering is still selected, right click to open the Lettering Object Properties dialog box.

Type BERNINA correctly in text box. Press OK.

Save As *lettering exercise.*
Save, stitch, and mount sample.

**artista 630E & 640E**
*Selecting Characters*
Select the Alphabet folder from embroidery menu. Select a font.

Touch desired letter on “keyboard” screen; it appears at top of screen. Select ABC icon for upper case letters; abc for lower case letters, ÄÅÄ for special uppercase letters, äåå for special lowercase letters, 123 for numbers; @# for other characters.

*Deleting Characters*
Select the <- arrow at the top right corner to delete characters in the text bar.

**artista 730E**
*Selecting Characters*
Select the Alphabet folder from embroidery menu. Select a font.

Touch the desired letter on the “keyboard” screen; it will appear at the top of the screen. Select the ABC icon for upper case letters; abc1,2,3 for lower case letters and numbers; @# for other characters.

*Deleting Characters*
Select the <- arrow at the top right corner to delete characters in the text bar.
Saving Text Designs

deco 330
Select Alphabet key. Touch the Font key. Select font style. Touch the desired letters on the “keyboard” screen. Use the A/a icon to toggle between upper and lower case letters. Touch OK.

Select the Editing tab. Touch the Save File key. Touch File Name key to assign file name. Key in file name. Touch OK; touch OK.

aurora 430E & 440QEE
Select File > Save As. Select location, type in file name, press OK.

Notes

artista 630E & 640E

Saving to Machine Memory
Touch Save in the Edit 1 screen. The lettering to be saved is displayed as NEW on left side of the screen. Select NEW motif; lettering is saved and machine returns to Edit screen.

Saving to a BERNINA® Personal Design Stick
Insert BERNINA® Personal Design Stick. Touch Save in the Edit 1 screen. Select the USB device icon from the Selection menu. The lettering is displayed as NEW on left side of the screen. Select the NEW motif; it is now saved on the BERNINA® Personal Design Stick.

artista 730E

Saving to Machine Memory
Go to Edit 1. Touch Save; motif appears as “Untitled”.

Lettering will be saved in My Designs.

Select lettering; a keyboard appears. Enter name of untitled design; touch OK.

Saving to a Personal Design Card or BERNINA® Personal Design Stick
Insert Personal Design Card or BERNINA® Personal Design Stick into slot or USB port in right side of machine.

Go to Edit 1. Touch Save; motif appears as “Untitled”.

Select design card icon or USB device icon.

Select untitled motif; enter name; touch OK.
Nothing is missing; this is an empty page.
Alphabet Sampler

decco 330
Select Alphabet tab. Select the first alphabet and program its name. Select the Editing tab. Move the word to the top of the hoop and center. Add the names of the remaining alphabet styles. Note: Cheltenham may need to be entered in small font size.

Add the two-letter monogram without a crest, and the three-letter monogram with a crest.

Embroidery. Press the carriage return key after finishing the last section to return the carriage to the stored position.

Trim and mount the sample.

aurora 430E & 440QEE
Open a New file. Left click on the Lettering Values icon. Left click on screen; a vertical cursor appears. Type Anniversary; the outline of the letters appears on screen. Press Enter; lettering is filled and selected.

While still selected, Copy and Paste a duplicate. Use the down arrows to move the duplicate word below the original. Right click to open the Lettering Object Properties box; change text in box to Guinevere, select Guinevere alphabet, click OK, and click away from the lettering to deselect it.

Press A on the keyboard to open the Lettering Object Properties box. Select King Charles alphabet; type King Charles, click OK. Click on screen below other words to set text. Click away from the lettering to deselect it.

Repeat for London and Swiss Block alphabets. Change first text block to Anniversary font. Arrange as shown. Note: Some alphabets may need to be reduced to fit within the hoop.

Save As alphabet sampler. Stitch, trim, and mount.

artista 630E/640E/730E
Select the first alphabet and program its name. Touch OK.

Select Large hoop. Go to Edit 2. Move the word to the top of the hoop.

Go to Edit 1. Use the Add Motif function to add remaining alphabet styles. Note: Some alphabets may need to be reduced to fit within the hoop.

Touch OK to process design combination. Stitch, trim & mount sample.

Monograms (decco 330 only)
Monograms Without Crest: Select Alphabet tab. Touch the Font key. Select 2-letter or 3-letter Monogram. Select desired characters. Touch OK.

Monograms With Crest: Select Alphabet tab. Touch the Font key. Select 2-letter or 3-letter Monogram. Select Crest style. Select desired characters. Touch OK.

Embroidery Fonts

deco 330
all alphabets

aurora 430E & 440QEE
all alphabets

artista 630E & 640E
all alphabets

artista 730E
all alphabets

Fabric & Stabilizer
8” x 10” rectangle
Alphabet Sampler

*deco 330*

*aurora 430E & 440QEE*

*Gothic Script Cheltenham*

*artista 630E & 640E*

*Anniversary Guinevere King Charles London Swiss Block*

*artista 730E*

*Alice Blackboard Childs Play Cursive Drifter King Charles Lisa London Swiss Block Varsity*
Manipulating Alphabets

decco 330
Select indicated alphabet. Select medium size font. Select vertical lettering. Program the word BERNINA. Move the word to the right. Select the Alphabet tab. Program Embroidery. Touch OK.

Embroider sample. Press the carriage return key after finishing the last section to return the carriage to the stored position.

Trim and mount sample.

aurora 430E & 440QEE
Left click on the Lettering/Values button on the design toolbar.

Place cursor on design screen; left click. A vertical cursor appears.

Select indicated alphabet; type BERNINA using the keyboard. Press Enter; lettering is filled and remains selected.

Use the Rotate CW/CCW tool to rotate the lettering 90°. Click outside the lettering to deselect it.

Repeat above instructions to add the word Embroidery to your design. Position it directly under the word BERNINA.

Save As manipulating alphabet. Stitch, trim, and mount.

artista 630E & 640E
Select indicated alphabet; program the word BERNINA, touch OK.

Select the Large Oval hoop. Go to Edit 2; rotate lettering 90°.

Touch Show Grid icon two times to activate grid. Move lettering so the lower edge of the letters rest on the center grid line.

Go to Edit 1; select Add Motif icon. Program Embroidery; touch OK. Use same process as above to rotate the word 90°. Move Embroidery directly under BERNINA.

Touch OK when editing is complete. Stitch, trim, and mount sample.

artista 730E
Select indicated alphabet; program BERNINA, touch OK.

Select Large Oval hoop. Select Edit 2. Touch Show Grid icon 2x to activate grid. Move lettering so lower edge of text box rests on center grid line.

Rotate lettering 90°.

Select Add Motif icon; program Embroidery; touch OK. Use the same process as above to rotate word 90°. Move Embroidery directly under BERNINA.

Touch OK when editing is done. Stitch, trim & mount sample.

Embroidery Font
decco 330
Cheltenham

aurora 430E & 440QEE
London

artista 630E/440E
Guinevere

artista 730E
Bamboo

Fabric & Stabilizer
8” x 10” rectangle
Manipulating Alphabets Sample

*deco 330*  
*aurora 430E & 440QEE*

*artista 630E & 640E*  
*artista 730E*
## Stitch Density

**Artista 640E/730E only**

### Artista 640E

Select London alphabet; type B; touch OK. Select Edit 2 and increase the size of the letter to 200%.

Select Edit 1. Select the Add Motif icon. Select London alphabet; type B; touch OK. Select Edit 2 and increase size to 200%.

Move second B to right of first B. Go to Edit 1; select Stitch Density icon; increase stitch density to 160%. Touch OK.

Select Add Motif icon. Select London; type B; OK. Select Edit 2; increase size to 200%.

Move third B to left of first B. Go to Edit 1; select Stitch Density icon; decrease stitch density to 40%.

Adjust placement of letters if needed. Note: Touch Grid icon two times to see grid and center mark.

Touch OK. Select Recalculate.

Embroider, trim, and mount sample, noting stitch density of each letter.

Note: Notice that the satin stitches moved closer together or further apart, while the straight stitches under the design remained unchanged. Stitch density changes affect both satin stitching and step stitching.

### Artista 730E

Select Drifter font; type B. Select Edit 2 and increase the size of the letter to 200%.

Go to Edit 1; duplicate design 2 times so that there are 3 Bs on screen.

Select Edit 2; move motifs so that they are aligned left to right. Note: Touch Grid icon two times to see grid and center mark.

Retrieve B on right. Select Motif Properties; alter satin density to 160%.

Retrieve B on left. Select Motif Properties; alter satin density to 40%.

Touch OK. Select Recalculate.

Embroider, trim, and mount sample, noting stitch density of each letter.

Note: Notice that the satin stitches moved closer together or further apart, while the straight stitches under the design remained unchanged.

### Embroidery Font

- **Deco 330**
  - n/a
- **Aurora 430E & 440QEE**
  - n/a
- **Artista 630E & 640E**
  - London
- **Artista 730E**
  - Drifter

### Fabric & Stabilizer

- 8” x 10” rectangle
# Stitch Density Sample

<table>
<thead>
<tr>
<th>Machine</th>
<th>Stitch Density Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>deco 330</td>
<td>n/a</td>
</tr>
<tr>
<td>aurora 430E &amp; 440QEE</td>
<td>n/a</td>
</tr>
<tr>
<td>artista 640E</td>
<td></td>
</tr>
<tr>
<td>artista 730E</td>
<td></td>
</tr>
</tbody>
</table>
Combining Motifs (On-Screen Editing)

decco 330
Select indicated motif. Select the Editing tab. Touch Rotate 45° one time.


Embroider. Return carriage to stored position. Trim and mount sample.

aurora 430E & 440QEE
Select File > Open > My Designs > Editor Lite folder > Floral6.art. Open.

Select File > Insert Design; My Designs > Editor Lite > Floral3.art. Open.

While inserted design is selected, left click twice on Rotate CCW/CW icon. Move to lower right of 1st design.

Copy and paste a 2nd floral swag. Mirror Image Up/Down; move to left.

Edit>Select All. Left click twice on Rotate CCW/CW icon.

Select Settings>Thread Colors. Select Thread Type > Isacord Shades
Assign thread colors:
- Color 1: 5531
- Color 2: 3910
- Color 3: 0015
- Color 4: 5531
- Color 5: 3920

Click OK.

Save As combining motifs.
Stitch, trim, mount sample.

artista 630E & 640E
Select indicated motif; select Large Oval Hoop.

Go to Edit 2. Touch Rescale Motif symbol; decrease size of motif to 80%. Touch Rotate Motif symbol 2 times to automatically rotate motif 90°.

Go to Edit 1; touch Add Motif icon to return to motif menu. Select 2nd motif. Touch Add Motif again; select 2nd motif again; there are now 3 motifs on screen with the last one on top.

Go to Edit 2. Select Move Motif and move motif up in the hoop. Rotate 90°. Use Retrieve icon to select other motif. Engage Mirror Image, rotate 90°, and use Move Motif icon to move selected motif to lower part of the hoop. When pleased with arrangement, select OK.

Embroider, trim, and mount sample.

artista 730E
Select indicated motif; select Large Oval Hoop.

Go to Edit 2. Touch Rotate Motif symbol twice to automatically rotate motif 90°.

Go to Edit 1. Touch Add Motif icon to return to motif menu. Select second motif. Touch the Duplicate Motif symbol. There are now 3 motifs on screen with the last one on top.

Return to Edit 2; top motif is active. Mirror Image motif both Right/Left and Up/Down. Use the Move and Retrieve functions to arrange motifs as desired.

When pleased with arrangement, touch OK. Choose Recalculation option. When processing is complete, embroider design. Trim and mount sample.

Embroidery Motif
decco 330
#50 - needle & thread
#30 - sewing border

aurora 430E & 440QEE
Floral6.art (Editor Lite)
Floral3.art (Editor Lite)

artista 630E & 640E
630E: #20 - flower 1; #19 - flower
640E: #26 - flower 1; #25 - flower

artista 730E
#14 - little wild rose
#16 - little pansies

Fabric & Stabilizer
8” x 10” rectangle
Combining Motifs Sample

*deco* 330

*aurora* 430E & 440QEE

*artista* 630E & 640E

*artista* 730E
Combining Lettering & Motifs (On-Screen Editing)

**deco 330**

Embroider. Return carriage to stored position. Trim and mount sample.

**aurora 430E & 440QEE**
Left click Hoop icon to turn off hoop display. Open Quilt8.art. Select motif; right click twice on Rotate CCW/CW icon. Left click Scale by 20% icon.

Copy and paste design; select Mirror Image Top/Bottom. Move motif to left.

Press A on keyboard to open Lettering Object Properties box. Select Anniversary, centered, 15mm height. Type Custom Creation; press Enter; type By, press enter, type your name, click OK. Click to set lettering between 2 designs. Adjust positioning to create a pleasing arrangement.

Left click on Hoop icon to turn on hoop display. Select Edit > Select All. Left click twice on Rotate CCW/CW icon. While selected, rescale combination to fit inside hoop using corner sizing handles.

Save As > motifs and lettering Stitch, trim and mount sample.

**artista 630E & 640E**
Select indicated motif; it opens in Edit 1 screen. Go to Edit 2. Reduce design to 70%; rotate 270°. Move to upper edge of hoop.

Go to Edit 1; select Add Motif icon. Select motif again. Reduce design to 70%; rotate 90°. Move to upper edge of hoop. Touch Show Grid icon two times to activate placement grid.

Go to Edit 1; touch Add Motif icon; select King Charles alphabet; input Bernina; touch OK. Go to Edit 2 and move motif to center of hoop.

Select Add Motif; select King Charles again; input artista 630E or 640E; touch OK. Go to Edit 2; reduce the selected lettering to 65%; move below the word Bernina.

Use Move Motif function to fine-tune design arrangement.

Embroider, trim, and mount sample.

**artista 730E**
Select indicated motif; it opens in Edit 1. Select Large Oval Hoop. Go to Edit 2. Reduce design to 80%; rotate -65°. Move to upper edge of hoop.

Select Duplicate icon to copy design. Rotate 2nd motif 155° functions. Move to lower edge of hoop.

Touch Show Grid icon 2 times to activate grid. Touch Add Motif icon; select Alice alphabet; input Bernina; OK. Select Edit 2; move text so lower edge is on horizontal grid line.

Select Edit 1, touch Add Motif icon. Select Alice again; input artista 730E; OK. Select Edit 2; move text so upper edge rests on horizontal grid line. Use Move Motif function to fine-tune design.

Touch OK to process multiple elements into a single design.

Embroider, trim, and mount sample.

**Embroidery Motif**
**deco 330**
#19 - fancy border
Gothic alphabet

**aurora 430E & 440QEE**
Quilt8.art (Editor Lite) Anniversary alphabet

**artista 630E & 640E**
630E: #8 Lace Panel 2
640E: #9 Lace Panel 2
King Charles alphabet (Font 1)

**artista 730E**
#8 - grape leaf
Alice alphabet

**Fabric & Stabilizer**
8” x 10” rectangle
Combining Lettering & Motifs Sample

*deco 330*

*aurora 430E & 440QEE*

*artista 630E & 640E*

*artista 730E*
Rehooping

**deco 330**
Draw a baseline. Hoop fabric at one end; use template to keep line vertical.

Select Gothic alphabet. Select vertical lettering. Program BERNINA; touch OK. Position needle starting point over baseline. Embroider.

Rehoop fabric with BERNINA at top, keeping baseline straight. Select Alphabet tab. Program deco 330. Position needle starting point over baseline at an appropriate distance from BERNINA. Embroider.

Return carriage to stored position. Trim and mount sample.

**aurora 430E & 440QEE**
Open a New file. Touch A on the keyboard. Type BERNINA 430E or BERNINA 440E; select Swiss Block, change height to 31.75mm, click OK. Click on screen to place lettering. Right click 2 times on the Rotate CW/CCW icon.

Note that lettering does not fit within hoop. Select lettering; click to open Lettering Values box. In text box, delete A 430E or A 440E, leaving the letters BERNIN; OK. Remaining letters fit within hoop.

Draw a line to represent design baseline. Hoop fabric, using hoop template to keep line straight and centered. Embroider BERNIN.

Return to Editor Lite screen.
Select lettering; right click to open Lettering Values box. In text box, delete BERNIN and type A 430E or A 440E; OK. Text fits in hoop.

Rehoop fabric, aligning baseline and positioning needle an appropriate distance from BERNIN. Embroider, trim, & mount sample.

**artista 630E, 640E, & 730E**
Draw a line to represent the design baseline. Hoop fabric in Medium hoop; use template to keep line straight and centered.

Select London alphabet; enter BERNINA. Go to Edit 2; rotate 90º. Touch OK.

630E/640E: Select Edit 2; move lower edge of text to marked baseline. 730E: Select Move Hoop; position needle over marked baseline. All: Using the template to keep the line straight, vertical and centered, embroider BERNINA.

Rehoop fabric. Select London again; enter 630E, 640E, or 730E. Go to Edit 2; rotate 90º. Touch OK.

630E/640E: Select Edit 2; move lower edge of text to marked baseline. 730E: Select Move Hoop; position needle over marked baseline. All: Position text an appropriate distance from BERNINA. Embroider, trim, and mount sample.
Rehooping Sample

*deco 330*

*aurora 430E & 440QEE*

*artista 630E & 640E*

*artista 730E*
**Free-Arm Embroidery**

**deco 330**
Select indicated motif. Select Editing tab. Select Hoop selection icon. Select A(F): 126 x 110mm. Touch OK.

Embroider sample.

Return carriage to stored position.

Trim and mount sample.

**aurora 430E & 440QEE**
Attach adapter and module to free-arm. Do NOT attach Small Hoop to module at this time.

Select indicated motif in Editor Lite.

Select the **artista** 50 x 72 Freearm hoop.

Select the Scale by 20% Down/Up icon, by RIGHT mouse clicking on it one time.

Save As **freearm sample**.
Stitch, trim, and mount.

**Notes**

**Attaching Spacer**
*Important Note: Use only the Small Hoop for free-arm embroidery.*

• Remove slide-on table.
• Place spacer on sewing machine arm. Push toward sewing machine to engage the lugs.
• Attach embroidery module.

**Removing Spacer**
• Remove module.
• Grasp right rear corner of spacer; remove from sewing machine.

**Embroidery Motif**

**deco 330**
#37 - flower frill

**aurora 430E & 440QEE**
Floral single.art (Editor Lite)

**artista 630E & 640E**
630E: #55 - snowflake
640E: #71 - snowflake

**artista 730E**
#14 - little Wild Rose

**Fabric & Stabilizer**
8” x 10” rectangle
Free-Arm Embroidery Sample

- deco 330
- aurora 430E & 440QEE
- artista 630E & 640E
- artista 730E
Baseline Sampler

decco 330
Select Alphabet tab. Select medium font size. Program BERNINA; touch OK. Move word up.

Select Alphabet tab; vertical lettering. Program BERNINA; OK. Move right.

Select Alphabet tab. Select Script font. Select Horizontal lettering. Program Bernina; touch OK. Rotate 45°. Move into position.

Embroider. Return carriage to stored position. Trim and mount sample.

aurora 430E & 440QEE
Select New; left click Lettering Values. Place cursor on screen; left click; vertical cursor appears.

Type aurora; outline appears. Press Enter; text is filled & selected.

Right click on lettering; Object Properties box opens with aurora in text box. Change lettering to Swiss Block; height = 20mm; OK. While selected, click arrow in Color Selection box; select C6; deselect to view changes.

Press A on keyboard; type aurora. Select Anniversary, H = 24mm; Clockwise baseline. Follow Status Line prompts (center, radius, circle or oval); Enter. Right click for Object Properties; change Baseline radius to 50°; OK. Select and change color to C10.

Select A key; type aurora. Select Vertical baseline; King Charles; H = 14mm; OK. Follow prompts; left click at top of column. While selected, change color to C4.

Save As > lettering baselines.

artista 630E & 640E
To create arched lettering, select, rotate, and place each letter individually. For greatest accuracy, use the hoop grid background to arrange letters.

Use indicated alphabet to input Bernina; select OK. Place in upper part of hoop.

Go to Add Motif; select indicated alphabet. Select B; place to left; rotate to fit an imaginary circle template. Go to Add Motif; select e; place to right of B. Rotate to fit imaginary circle template.

Continue in this manner, adding letters to complete Bernina. Select Retrieve; fine tune letter placement.

Repeat this process to form additional baselines.

artista 730E
To create arched lettering, use Letter Manipulation dialog box.

Use Alice alphabet to input Bernina; OK. Select Medium Hoop; select Duplicate.

Go to Edit 2. Select Letter Manipulation symbol; Vertical Baseline; OK. Select Move Motif; use Stitch Length (-300) & Width (+100) knobs to move vertical Bernina to left.

Retrieve 2nd Bernina. Using default baseline (Horizontal), move lettering to Length knob = +100 & Width = +350. Go to Edit 1; Duplicate. Go to Edit 2; Select Letter Manipulation; Curved Baseline ABOVE smallest green circle; OK. Move Bernina to Stitch Length knob = +150 and Stitch Width knob = +100.

Go to Edit 1; Duplicate. Go to Edit 2; select Letter Manipulation. Choose Curved Baseline BELOW smallest circle. Position word at Stitch Length knob = +150 & Width knob = -400. Touch OK.

Embroidery Alphabet
deco 330
Gothic & Script

aurora 430E & 440QEE
Swiss Block, Anniversary, & King Charles

artista 630E & 640E
Swiss Block

artista 730E
Alice

Fabric & Stabilizer
8” x 10” rectangle
Baseline Sampler

- deco 330
- artista 630E & 640E
- aurora 430E & 440QEE
- artista 730E

©2006 BERNINA® of America, Inc. Permission to copy granted only to Authorized BERNINA® Dealers
Changing Lettering Height

**deco 330**
Select Alphabet tab. Select small font size. Program BERNINA; touch OK. Move word up.

Select Alphabet tab. Select medium font size. Program BERNINA; touch OK. Move up.

Select Alphabet tab. Select large font size. Program BERNINA; touch OK. Position as needed.

Embroider. Return carriage to stored position. Trim and mount sample.

**aurora 430E & 440QEE**
Open a New file. Press A (on keyboard) to open Lettering Object Properties. Select King Charles, height 14mm. Type aurora; press Enter; OK. Click to see lettering.

Copy & paste to create 5 auroras.

Select second aurora; right click to open Lettering Object Properties. Change height to 20mm; OK.

Note: Third & fifth auroras will be used in next exercise, Changing Letter Spacing.

Select fourth aurora; click & drag top center sizing handle to adjust height of lettering.

Reposition as desired. Save As lettering height & spacing. Do not stitch until after next exercise.

**artista 630E/640E**
While lettering can't be resized directly on the 630E/640E, the size of the lettering object can be changed using the Proportional Resizing tools.

Open alphabets; select Swiss Block. Enter BERNINA; OK. Select Large Oval Hoop.

Using the Add Motifs tool, add four additional BERNINAs to create a total of five copies. Use the Move Motif and Retrieve functions to arrange the words as shown in the illustration.

Select Edit 2; use the Retrieve and Proportional Resizing tools to change each BERNINA to a different size as shown.

**artista 730E**
Open alphabets; select Drifter. Enter BERNINA; OK. Select Medium Hoop.

Duplicate BERNINA to create a total of five copies. Use the Move Motif and Retrieve functions to arrange the words as shown in the illustration.

Select BERNINA at top of hoop. Touch Letter Manipulation symbol and change Letter Height to 6mm. Touch OK. Use positioning functions to move the word to Stitch Length knob = +500, Stitch Width knob = 0.

Repeat this process for each BERNINA as indicated below: Note: Stitch Width knob position = 0 for all words.

1: Height = 6mm SL knob = +500
2: Height = 10mm SL knob = +350
3: Height = 14mm SL knob = +150
4: Height = 18mm SL knob = -100
5: Height = 20mm SL knob = -400

When combination is complete, touch OK. Stitch, trim and mount sample.
Changing Lettering Height Sample

deco 330

Bernina
Bernina
Bernina
Bernina
Bernina
Bernina
Bernina
Bernina

aurora 430E & 440QEE

aurora
aurora
aurora

aurora

artista 630E & 640E

artista 730E

aurora
bernina
bernina
bernina
bernina
bernina
bernina
bernina
bernina
Changing Letter Spacing

(aurora 430E/440QEE & artista 730E only)

**aurora 430E & 440E**

The last exercise – Changing Lettering Height – should still be on the screen.

Select the third _aurora_; open Lettering Object Properties. Change letter spacing to 3.5; click OK.

Select the fifth _aurora_; select the Reshape icon. Adjust letter spacing manually by clicking on the diamond-shaped control points and sliding the letters along the baseline.

Reposition as desired. Save As _lettering height & spacing_. Stitch, trim, and mount sample.

**artista 730E**

Open alphabet folder; select King Charles alphabet. _artista_; touch OK. Select Medium Hoop.

Duplicate _artista_ to create a total of three copies. Use the Move Motif and Retrieve functions to arrange the words as shown in the illustration. Note: _Stitch Width knob position = 0 for all words._

1st _artista_  
Height = 14mm  
Stitch Length knob = +300

2nd _artista_  
Height = 14mm  
Stitch Length knob = 0

3rd _artista_  
Height = 14mm  
Stitch Length knob = -300

The top _artista_ has no spacing changes.

Retrieve middle _artista_. Touch the Letter Manipulation symbol and change the Letter Spacing to 3mm. Touch OK.

Retrieve last _artista_. Change spacing to 5mm. Touch OK.

Embroider combination in the Medium Hoop. Trim and mount sample.
Changing Letter Spacing Sample

- **deco 330:** n/a
- **aurora 430E & 440QEE:**
  - n/a
- **artista 630E & 640E:**
  - n/a
- **artista 730E:**
Mega Hoop
*(artista 630E/640E & 730E only)*

**artista 630E & 640E**
Hoop fabric and stabilizer in the Mega Hoop. Put clamps into the designated notches and attach hoop to the *artista* 630E/640E.

Select the London alphabet. Enter **Discover Your Creative Wings**; touch OK.

Select Edit 2. Touch the Rotation Arrows to automatically rotate the design 90°.

Enlarge text to the length of the Mega Hoop. Touch OK.

The *artista* will instruct you to reposition the Mega Hoop. Press the *front clip only* and gently push or pull the hoop until the attachment mechanism clicks in the place in the desired position. The *artista* will instruct you to check that the notch is firmly in position. Press OK to confirm.

Stitch. The *artista* will prompt you to reposition the hoop when needed. Follow the screen directions to complete stitching the design.

Trim and mount the sample.

**artista 730E only**
Hoop fabric and stabilizer in the Mega Hoop. Put clamps in designated notches and attach hoop to the *artista* 730E.

Select the Blackboard alphabet. Enter **Nothing Sews Like A BERNINA. Nothing!** Touch OK.

Select Edit 2. Touch the Rotation Arrows to automatically rotate the design 90°. Enlarge text to the length of the Mega Hoop. Touch OK.

The *artista* will instruct you to reposition the Mega Hoop. Press the *front clip only* and gently push or pull the hoop until the attachment mechanism clicks into place in the desired position. The *artista* will instruct you to check that the notch is firmly in position. Press OK to confirm.

Stitch. The *artista* will prompt you to reposition the hoop when needed. Follow the screen directions to complete stitching the design.

Trim and mount the sample on the following page.
## Mega Hoop Sample

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>deco 330</td>
<td></td>
</tr>
<tr>
<td>n/a</td>
<td></td>
</tr>
<tr>
<td>aurora 430E &amp; 440QEE</td>
<td></td>
</tr>
<tr>
<td>n/a</td>
<td></td>
</tr>
<tr>
<td>artista 630E &amp; 640E</td>
<td></td>
</tr>
<tr>
<td>artista 730E</td>
<td>Discover Your Creative Wings</td>
</tr>
<tr>
<td></td>
<td>Nothing Sews Like A BERNINA. Nothing!</td>
</tr>
</tbody>
</table>
myartista Portal

(artista 730E only)

**artista 730E**

With the **artista** turned off, connect the **artista** 730 Dial-Up Modem (optional accessory) to a dial-up phone line and to the **artista** 730E.

Access a Dial-Up Internet Service Provider:
- select Setup and touch Portal provider settings
- touch the red circle to select an empty provider slot
- touch the bar next to the check mark
- touch the provider bar and key in the provider's name; touch OK
- touch gray Number bar; touch yellow Number bar to erase line
- enter the phone number used to access the provider; touch OK
- touch gray User Name bar; touch yellow User Name bar to remove line
- enter your user name; touch OK
- touch gray Password bar; touch yellow Password bar to remove *****
- touch ESC to exit Setup

**Note:** Passwords are case sensitive. Use upper and lower case lettering where needed.

Select the Portal icon. This message appears: **A modem connection is required. Do you want to connect to:** ________ Touch Yes.

A **Connecting...** message appears at lower edge of the touch screen.

When **The modem is connected successfully to:** ________ appears, touch OK.

Select Large Oval from the available choices.

This message appears: **A modem connection is active. Do you want to disconnect?** Touch No.

Select the Save icon. Select the Untitled design; enter a name for the design, which you will stitch out later.

The **artista** 730 will again ask if you want to disconnect. Touch No.

Return to the Portal icon to retrieve additional designs. When finished, disconnect at prompt. Unplug cable from **artista** 730.

Retrieve one of the Portal designs from your My Designs folder. Embroider and trim sample, then mount on the following page.

**Note:** To access broadband (high speed) Internet, download and follow the BERNINA® Ethernet LAN Card Instructions from www.berninausa.com > my artista > artista Technical.
myartista Portal Sample

<table>
<thead>
<tr>
<th>Machine</th>
<th>Portal Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>deco 330</td>
<td>n/a</td>
</tr>
<tr>
<td>artista 630E &amp; 640E</td>
<td>n/a</td>
</tr>
<tr>
<td>aurora 430E &amp; 440QEE</td>
<td>n/a</td>
</tr>
<tr>
<td>artista 730E</td>
<td>n/a</td>
</tr>
</tbody>
</table>

Use any embroidery design from the myartista Portal
Beyond the Basics Shopping List

- Embroidery Collections
  - ____________
  - ____________

- OESD Cut-Away Stabilizers
  - Heavyweight Cut-Away
  - Xtra Heavyweight Cut-Away
  - Hydro-Stick Cut-Away
  - Cut-Away Poly-Mesh
  - Fusible Poly-Mesh
  - Stabil-Stick Cut-Away

- OESD Tear-Away Stabilizers
  - Lightweight Tear-Away
  - Smooth Touch Tear-Away
  - Medium Weight Tear-Away
  - Hydro-Stick Tear-Away
  - Ultra Clean & Tear
  - Stabil-Stick Tear-Away

- OESD Water-Soluble Stabilizers
  - Aqua Film Topping & Backing
  - Badge Master Wash-Away
  - Aqua Mesh Wash-Away
  - Aqua Mesh Plus (adhesive-backed)

- Spray Starch
- Brush/Paint-On stabilizer products
- Fusible Interfacing products
- HRFive Temporary Spray Adhesive

- Embroidery Needles - mixed #75/90
- Organ Embroidery Needles
  - #70/10 Sharps
  - #80/12 Sharps
  - #90/14 Sharps
  - #70/10 Ballpoint
  - #80/12 Ballpoint
  - #90/14 Ballpoint

- ABCs of Embroidery
- Sew Much Fun
- A Touch of Artistry I
- Seasons of Artistry
- Through the Needle magazine

- Isacord Embroidery Threads
  - colors ________

- Yenmet Metallic Embroidery Threads
  - colors ________

- Other Embroidery Threads
  - color ________

- Supplemental Thread guide
- Multiple Spool Holder
- Bobbin Thread
- BERNINA® and OESD Thread Boxes
- Plexiglass Table
- Large Plexiglass Table
- Suitcase System
- Reader/Writer Box
- USB Card Reader from OESD
- Personal Design Card or USB Stick
- Magic Box Plus & artista Magic Card
- Mini Magic Box Plus & artista Magic Card
- BERNINA® Dial-Up Modem
- BERNINA® Ethernet LAN Card

- BERNINA® Embroidery Software
  - Editor
  - Auto-Designer
  - Designer Plus
  - OESD eXplorations Software

- deco 330 Embroidery Hoops
  - Free-Arm Hoop
  - Round Hoop

- aurora/artista Embroidery Hoops
  - Small Embroidery Hoop
  - Freearm Adapter (spacer)
  - Medium Embroidery Hoop
  - Large Oval Embroidery Hoop
  - Hoop 'N' Buddys Hat Hoop Insert (fits Large Oval Hoop only)
  - Mega Hoop (artista 630E/640E/730E only)

- Hoop-It-All™ Hoops
  - Quilters Square Double Wide
  - Super Double Wide
  - deco 300 Double Wide
  - Big/Cap Hoop